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YOU CAN 

DRAFT A RESUME! 

 

 



WHAT IS A RESUME? 
A resume is a summary of your experience, education, skills and qualifications for a 
specific job objective.  It is a marketing tool which an employer reads, even before 
meeting you!  The purpose of the resume is to create enough interest in you so that 
you are called for an interview! 

 

GENERAL GUIDELINES 
 

Here are several points to remember when writing a resume: 

1. There is no one perfect way to write a resume.  One size does not fit all. 

2. A resume is read in approximately 30 seconds, so be sure to prioritize the    

order in which the information is presented. 

3. Don’t be surprised if you must write several drafts.  Write down all of your 

experience on paper and revise it later. 

4. The organization must be reader friendly: spacing, layout, and headings must 

be    visually appealing. 

5. Use bold, italics, and underlining for emphasis. 

6. Use font size 11 or 12 for your resume.  You may use a font as small as size 

10, especially when you need to fit a lengthy history into two pages.   A font 

style such as Times New Roman or Arial is easy to read. 

7. Consistency is important: if you italicize one job title, italicize all of them. 

8. Do not abbreviate except for states, college degrees. 

9. Include all experiences related to the job objective even if they were             

volunteer experiences. 

10. Remember that your resume must be attractively presented; must have a sense 

of direction, professionalism, and honesty; must focus the reader on your 

strongest points as well as your career goals. 

11. The best resumes are customized to each position you are seeking. 
. 

PROPER LENGTH 

The old rule that a resume must be one page does not follow.  

Resumes for teaching or human services positions such as 

nursing and psychology are often more than one page.  Student 

teaching experiences, clinical experiences, and other forms of 

professional training cannot be limited to a one page resume.  

If a resume must take up more than one page, it should fill up 

at least half of that second page.  Be sure that your name is at 

the top of the second page, along with Page 2.  If your resume 

is to be scanned, key words and phrases are essential to qualify 

you for the position you are seeking.  This will make your re-

sume longer than one page. 
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Functional Resume:  This format re-arranges your employment history into sections which highlight your skills 

and accomplishments.  It allows you to emphasize your skills and eliminate the tendency to repeat similar experience.  It is a sum-
mary of your work experience organized around skill areas.  Skill areas are used as section headings.  Limit your skill headings to 

no more than five and use only skill headings that support your objective.  Examples of skill areas include: 
 

Accounting and Budgeting    Management and Coordination 

Advertising and Marketing    Supervision 
Counseling and Advising    Teaching 

 
Under each skill area you list the duties and specific job tasks performed and any accomplishments which demonstrate your profi-

ciency.  Bullet each duty, job task and accomplishment and begin each bulleted sentence with an action verb. 
 

We recommend that you use a functional resume if: 
 

 A.   You are changing careers 
 B.   You have noticeable gaps in your employment history 

 C.   You don’t have a great deal of experience related to the position you seek. 

 

Chronological Resume:  This is a summary of your work experience, lists your past jobs in date order 

with the most recent job first.  It organizes your professional experience around past positions and employers.  It includes the 
name of the organization, the location (city and state), dates of employment, job responsibilities, duties and accomplishments in 

terms of benefits to the employer.  For each job you list, you include between 3-5 major duties and begin each bulleted sentence 
with an action verb. 

 

The chronological resume is preferred by employers and should be used if you: 
 Have a history of employment that show stability 

You’ve been working in the same field for awhile 
You’ve had a steady upward progression of titles and levels of responsibility 

You have not been a job-hopper 
 

The disadvantage of using a chronological resume is that this format places emphasis on employment gaps.  In addition, this 
style 

has no flexibility in presenting your transferable skills when you are changing careers or when related work experience is mini-
mal. 

Hybrid Resume:  This resume combines the skills section of the functional resume and the employment his-

tory of the chronological resume.  The employment history is a short summary of your past employers, their name, location, 
and your job title.  If you have a solid work history, include the dates of employment as well.  Employment History follows 

immediately after the skills section. 
 

We recommend that career changers with a solid work history use a hybrid (combination) resume, which allows you to take 

the best parts of both functional and chronological formats and helps to position yourself in as positive a light as possible. 
 

Internships should be considered work experience and placed in the Work Experience section of the resume, however, you 
must indicate that it is an internship.  
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CHRISTINE LIN 

20 Colonial Drive, Apt. A 

New Paltz, NY  12561 

(845) 255-0000 

ln98@cs.newpaltz.edu 

 

OBJECTIVE  A position that will utilize my skills in computer programming 

 

EDUCATION B.A. Computer Science, December 2006 

   State University of New York, New Paltz 

   Major GPA:  3.3 

 

   A.A. Computer Science, June 2002 

   Dutchess County Community College, Poughkeepsie, NY 

   Major GPA:  3.4 

 

SKILLS  Proficient in C/C++, PERL, JAVA, VISUAL BASIC, HTML 

   Experienced in UNIX systems administration 

Familiar with Windows 97, 98, 2000, DOS, Macintosh, 

Microsoft Office Suite (Word, Excel, Access) 

 

SIGNIFICANT 

PROJECTS Completed project simulation of cashiers in a supermarket.  Defined object-oriented 

functions such as function, virtual methods, virtual base-classes, inheritance, and poly-

morphism.  Concluded that business with one line and many servers is more efficient 

than one line for each server. 

 

EXPERIENCE Web Page Designer,  May 2003 – 2006 

 SUNY New Paltz Computer Services Center 

   Design Web pages for academic department using HTML, JAVA      

   Applet, and PERL-scripts, and perform regular maintenance and up  

   grades.  Run workshops on HTML for college staff. 

 

   Tutor, September 2003 – 2004 

   SUNY New Paltz Computer Science Department 

   Tutored up to 20 first and second year students in C++ and algebra    

   courses 

 

   Computer Assistant, June 2002 – 2003 

   Lucky Enterprises, Poughkeepsie, NY 

   Installed software, configured hardware, did troubleshooting.  Built   

   computers and installed many ethernet networks. 

 

LANGUAGES Bilingual in English and Mandarin.  Permanent residents of U.S. 

 

 

Sample Resume:  Times New Roman #12 (Chronological Style) 
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Robert MacIntyre 
1001 Long Shore Street 

Evanston, IL 12345 

(123) 555-1234 

MacIntyre@thenet.net 

 

JOB OBJECTIVE 

Environmental Health & Safety Coordinator 

 

SUMMARY OF QUALIFICATIONS 

10 years as an Environmental Compliance Professional with recent experience in Environmental Pro-

tection and OSHA compliance. 

Demonstrated ability to build rapport and resolve complex issues among multiple entities with conflict-

ing interests. 

Working knowledge of industrial and research settings. 

 

PROFESSIONAL EXPERIENCE 

1995-present SIDNEY LABS (SL), Chicago, IL 

  Environmental Compliance Specialist 
 

LEADERSHIP 

As Facility Coordinator for a building on the University of Chicago campus, closed out 85% of 1800 

deficiencies, turned around maintenance and custodial standards, implemented a recycling program, 

and improved security 

As Chairperson of the Life Sciences Division Safety Committee, revitalized the group, improved pro-

ductivity, increased recognition within SL, and facilitated a self-assessment inspection program 

Served as liaison between Principle Investigators and Environmental Health and Safety (EH&S) Divi-

sion.  Developed strategies for EH & S compliance including OSHA and waste management 

As Manager of the Medical and Biohazardous Waste Program, developed a comprehensive compliance 

document including a generator’s guide and training plan.  Program was fully implemented in only five 

months. 

 

COMPLIANCE ENFORCEMENT 

Conducted advice visits to hazardous and mixed waste generators to review procedures, labeling prac-

tices, and adherence to accumulation time limits. 

Updated and managed the Underground Storage Tank (UST) Program, which included the creation of 

four-page Monitoring Plans that were used as models by the Department of Energy (DOE) 

Coordinated certification of tanks and secondary containment for six Permit-by-Rule (PBR) Hazardous  

Waste Treatment Units.  Ensured upgrades were in compliance and directed the permit writing effort 
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1994-1995 SAFETECH, Springfield, IL 

  Environmental Compliance Consultant 

 

An environmental consulting firm providing support to DOE facilities 

 

Developed and wrote the first-ever Quality Control Inspection Plan/Procedure to monitor quality assur-

ance of Pleasant Hills Laboratories’ Hazardous Waste Management storage and treatment facilities.  

Plan was incorporated into their Part B Permit. 

Audited hazardous waste management facilities and Waste Accumulation Areas (WAAs) for compli-

ance with EPA and Cal-EPA regulations, and DOE policies.  Waste included:  hazardous, Radioactive 

(high and low level), and mixed. 

 

1990-1994 US AIR FORCE, Wichita, KS 

  Environmental Program Manager, 1993-1994 

  Environmental Compliance Specialist, 1993 

  Chemist, Materials Engineers, 1990– 1993 

 

An aircraft re-work facility comprised of 125 manufacturing shops and a materials engineering laboratory. 

 

Ensured EH & S compliance in 75 WAAs by performing frequent surveillance and enhancing the 

training program 

Co-developed directives for issues including waste minimization, solvent substitution, recycling, 

chemical storage, fire safety, and OSHA standards 

Directed preparation of individual shop contingency plans for the site Hazardous Material Manage-

ment Plan 

 

1987-1989 MARION RIGGS HIGH SCHOOL, Topeka, KS 

  Physical and Inorganic Chemistry Advanced High School Teacher 
 

1984-1987 TOXMOX Inc., Topeka, KS 

  Chemist, 1987 

  Lab Technician, 1984-1987 

 

EDUCATION 

B.S., Biochemistry, Emporia State University, Emporia, KS 1985 

 

Seminars: OSHA/RCRA   Emergency Preparedness 

  Hazardous Materials  Hazardous Waste 

  Fire Safety   Underground Storage Tanks 

  Medical Waste  Radioactive and Mixed Wastes 

 

 

SOURCE:  Internet (JobStarCentral) - http://jobstar.org/tools/resumes/res-chr4.php 

Sample Resume:  Hybrid Chronological —Times New Roman #12 
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MARYANN HOWSER 

5001 Kanova Place 

Santa Barbara, CA  931703 

 
REAL ESTATE ASSOCIATE 

PROFESSIONAL PROFILE 

Experienced in client relations, sales & promotions. 

Organized, dedicated with a positive attitude. 

Outstanding talent for assessing people’s needs. 

Proven ability to gain clients’ confidence and trust. 

Gained valuable business and personal contacts throughout the Santa Barbara community. 

Passed Real Estate Salesman’s Examination, 1990. 

EXPERIENCE 

Real Estate Experience 

Assisted in the design, construction & sale of a Santa Barbara condominium. 

Established an effective marketing strategy to promote the sale of property. 

Designed flyers and newspaper advertising; distributed flyers. 

Arranged and conducted open house. 

Familiar with blueprints and architectural plans with understanding of conceptual design. 

Sales, Promotions & Organization 

Organized and coordinated an entire summer tennis program for children at a private tennis club in Monte-

cito. 

Promoted services through effective telemarketing techniques, through product knowledge and exceptional 

client relations. 

Compiled computer data to keep track of profits & losses of monthly sales. 

Client Relations 

Interface with clients and members to interpret their needs and priorities. 

Develop innovative, non-competitive teaching techniques for adults and children, focusing on individual 

strengths. 

Advise clients and members in a professional and concerned manner, securing their trust and confidence. 

EDUCATION & LICENSES 

California Real Estate Salesman’s License,        1990 

BA Degree, Communication, UC Los Angeles,  1979 

 

EMPLOYMENT HISTORY 

Tennis Instructor, A Tennis Club, Montecito, CA    1989- present 

Teacher’s Assistant, Los Angeles School District    1986-88                  Pre-School 

Teacher, Children’s Pre-School, Los Angeles, CA   1983-85 

Tennis Instructor, City of Los Angeles, Recreation Dept.   1978-80 

 

SOURCE:  The Resume Guide for Women of the 90’s by Kim Marino.  Ten Speed Press, 1992 

Sample Resume:  Times New Roman #11(Functional Style) 

             (805) 569-2220 
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Your full name (in all CAPITAL LETTERS and/or bold) 

Complete Address (list permanent and present addresses if in college) 
Home and/or mobile phone numbers 

E-mail address (Make sure your email address does not sound unprofessional) 
 
 

OBJECTIVE  After the contact information, you would list our Career Objective.  The experts’ opinion   

    is split on whether to  use an objective.  We recommend, if you are applying for a          
     specific position to include an objective.  

 
The exact job title of the position you are seeking; keep it brief! 

Your resume is built to support the objective.  You must show what qualified you for this ca-

reer. 
 

This heading appears after the career objective. This section is also optional and can be included if you have 
an impressive list of skills, achievements, or accomplishments.  If you include a summary section, keep the 

statements concise, using action verbs and be results oriented.  Think of it as a headline in an effective print 
advertisement. 

 
Three, four, or five short highlights of your most impressive qualifications for the job. 

This can be anything from skill areas and accomplishments to personality traits.  Bilingual 
capabilities also belong here! 

Do not repeat what appears elsewhere in the resume. 

 

EXPERIENCE  CHOOSE  OPTION “A” or “B” 

   (required) 

 A.          EXPERIENCE 

 

          or 
 

 B.  RELATED EXPERIENCE  (related to Objective) 

          and 
  OTHER EXPERIENCE (not related to Objective) 

 

If you choose ―B‖, you are indicating that you have work that is related to your objective as 
well as other work experience that is not related to that same objective. 

A list of past employers, starting with your most recent first. (Chronological Resume) 
List employer’s names, addresses and dates of employment and job titles. 

Job Titles are written in BOLD FACE, and listed under each job title is a short description of 

the tasks and accomplishments you performed for each employer.  Begin with an action verb.  
Use same verb tense for each verb.  Use bullets. 

Functional Resumes are organized around skill sets and not formatted around the employer 
and dates of employment. 

Your general skill areas are used as section headings (Computer Skills, Customer Service, 
etc.) 

Under each skill area list those specific job tasks and accomplishments that demonstrate your 
proficiency in that skill area.  Begin with a verb.  Use same verb tense.  Use bullets. 

SKILL SUMMARY 

            or 

HIGHLIGHTS OF 

QUALIFICATIONS 

            or 

PROFESSIONAL 

PROFILE  

(optional) 
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Highlight your most recent degree, and the colleges or trade schools you attended; put in reverse 
chronology (most recent school and move backwards). 

List any awards, Dean’s Lists, or school projects that pertain to your career objective. 
If you do not have a college education, mention your high school and diploma. 

For recent college graduates, under Education, choose another category and write it in BOLD 

FACE:  call it Related Course Work or Course Work in Progress.  List exact course titles under 
appropriate category.  This gives greater credibility to your qualifications. 

 
Mention only that personal information that pertains to your job objective; for example:  Honors, 

Awards, Licenses, Certifications Professional Associations, Activities, and Publications, Internships, 

and Volunteer Work.  These belong in separate categories of their own, in BOLD FACE. 

 

SPECIAL SKILLS – (in BOLD FACE). You may want to mention interests and activities that dem-

onstrate job-related skills (leadership, organization, etc.); special abilities, such as knowledge of 

computers or a foreign language; and/or honors or awards earned.  Do not include personal data, 
such as age and health status.  This might also go under Highlights of Qualifications. 

The headings, or sections that comprise the resume, outline the job seekers professional capabilities and qualifications to perform a job.  
The resume is a marketing tool and its purpose is to secure a job interview.  Therefore, the headings you decide to include in your re-

sume must be chosen carefully, keeping in mind how you can best feature your qualifications to a prospective employer.   
 

Some headings are standard and employers expect to see them when they review a resume.  The required headings include your contact 
information, work experience and skills, education and training. 

ORGANIZATION OF THESE HEADINGS 

 

Remember that EMPHASIS is the key to organization.  

What is more impressive:  your work experience or your 

education? 

If you are a recent graduate with limited professional ex-

perience, then your education would be more impressive, 
and you would want to put all emphasis on it.  Therefore, 

the Education heading would be placed before Experi-

ence. 

What if you have a strong work history but your most out-

standing achievements are from jobs previous to your last 
one?  What do you stress, your steady work history 

(chronological format) or your achievements (functional 
format)?  You are worried that if you follow the chrono-

logical format, and list your last job first, your most im-
pressive qualifications will be buried.  In this case, you can 

go with the more acceptable chronological format , but 
include a short Summary of Qualifications to emphasize 

your most impressive accomplishments and skills first, 

and still present your strong chronological background. 

EDUCATION 
(required) 

ADDITIONAL 

PERSONAL 

 INFORMATION 

 

WHAT MUST NEVER GO ON A 

 RESUME! 

 Keep your resume focused on your skills and 
accomplishments.  Never mention personal information, 

controversial information or anything negative about 
yourself.  Do not put references on your resume.  They 

belong on a Reference Sheet, a separate document. 

 

NEVER MENTION THE FOLLOWING: 

RACE 

RELIGION 

MARITAL STATUS 

POLITICAL AFFILIATION 

SALARY REQUIREMENTS 

REASONS FOR LEAVING A PAST JOB 
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SUMMARY OF QUALIFICATIONS 

 

 

The ―Summary of Qualifications‖ or the ―Highlights of Qualifications‖ is optional.  It will not ruin a resume if it is not present, but properly done, it can be 

an effective tool!  A definition of the Summary might be as follows: 

Short statements that highlight your most impressive qualifications and achievements 

The purpose of the summary is to immediately grab the employer’s                      

        attention and impress him.  It can be customized to fit the job you are pursuing. 

An effective summary will generate serious attention. 

To be effective, the statements must be concise, written with impact (action verbs),  and                                                                                   

be result oriented.  

 

Generally speaking, the following points hold true: 

DO NOT  INCLUDE A SUMMARY IF…… 

 *You do not have an impressive list of skills and achievements. 

 *You have already highlighted your most impressive skills in your objective. 

 

BE SURE TO INCLUDE A SUMMARY IF….. 

Your resume is in chronological format.  Since the focus of such a resume is on dates of employment and job titles, you should utilize 

the summary to highlight your skill areas as well as any major achievements that may get buried in the body of your resume. 

You have made a significant achievement to a past employer. 

You have a unique combination of skills. 

You have received prestigious awards or honors 

                                                                   

Your summary is very much like an advertisement.  It announces what you have to offer.  Like an advertisement, each statement must be concise, full of 

punch, and be impressive. 

 

Remember that you must sell yourself; put plenty of ―sell‖ into the ―Summary of Qualifications‖: 

1. List your most impressive qualifications – those that will be used to solve problems for your employer. 
2. List your most important accomplishments—problems that you have solved or results that you were directly responsible for in your past 

work experience. 
3. List personal qualities that would impress any employer.  Highlight those qualities that will grab the employer’s attention, such as ―more 

than 15 years experience,‖ ―ability to work well under pressure,‖ ―scored 97% on Manager’s Training Test.‖ 
 

YES 

MAYBE 

NO
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A skill is an ability which you take from job to job.  Your skills are visible as you carry out your duties at work.  Whenever you are 

looking for work, you need to know what skills you possess which can be applied to the job. 

There are three basic skills areas: 

 

A.   TRANSFERABLE:  Skills which allow you 
to work with people, data and/or things.  

Some examples include 
 

Organizational 
Management 

Analyzing 

Customer Service 
Teaching/Counseling 

Communication/Selling  
                                    (Oral and Written Skills 

B.   SELF-MANAGEMENT:  Skills     
related to your personality and to  

other people in the work environment.  
Some examples include    

 
Punctuality 

Attention to Detail 

Initiative 
Sense of Humor 

Productive 
Honesty/Loyalty 

        C.    JOB-RELATED:  Skills that you need to perform                     
 on the job.  To identify these skills, you need to 

 know what job you want!.  Some examples might 
 include 

 
         Accounting/Bookkeeping 

         Writing Business Correspondence 

         Proficiency in Specific Computer  
            Programs 

        Handling a Multi-line Phone System 
        Teaching Games to Pre-Schoolers, 

             ages 3-5. 

You need to identify your skills which can help you when writing your resume.  You can incorporate these skills into your Summary of Qualifications 

section, or Profile. 

 

Source:  Michael Farr’s America’s Top Computer and Technical Jobs , JIST Publishing, Inc.  2003 

 

KNOW YOUR SKILLS         Page 12  

 



FINAL TIPS FOR DEVELOPING AN EFFECTIVE RESUME    Page 13 

 

A resume should be tailored specifically for the kind of job/organization/career you are seeking.  This means you may have to write more than one 
resume if applying for different types of jobs. 
 

BEFORE YOU CAN WRITE AN EFFECTIVE RESUME, you must be able to identify your skills, abilities, and interests and be able to relate them to the job/
industry/career field in which you are seeking employment. 
 

If you are unsure about the types of jobs/industries/organizations/careers you are targeting, make an appointment with the Office of Career & Intern-

ship Services to help you in developing some focus.  Employers cannot (and will not) decide what career is best for you; you must be able to commu-

nicate what skills and abilities you have that fit the specific job or jobs they are trying to fill. 
 

RESUME TIPS:   

 

Focus on the employer’s needs, not on your own needs. 
Quantify your experience wherever possible.  For example, ―Supervised others‖ can be made more 

clear by stating ―Supervised three cash register attendants.‖ 
Use action verbs in describing your skills and experience. 

 

        Instead of….Responsible for assisting with preparation of sales tax         

        reports each month 

        Write...Assisted in preparation of monthly sales tax reports. 
 

        Instead of...Was in charge of organizing and taking care of spring                             
        rush activities 

        Write….Organized and directed spring rush activities for over 50                                      
         new sorority pledges.  

Keep the resume to one page unless you have ten or more years of professional experience or devel-

opmental training. 
Avoid abbreviations except for words such as Corp. or Inc.  States may also be abbreviated (NY, MA, 

NJ, CA).  Acronyms are also acceptable:  RN, COTA, OTA, LPN, and so on. 
Use bulleted phrases starting with the action verb to describe your duties on the job. 

Do not make any reference to yourself: I, me, we, and so on. 
Job descriptions should be results oriented (e.g. Shortened customer wait time in reception area by 

40 minutes) 
Begin with recent work experience and work backwards. 

Use indentation, underlining, bold, and CAPITALIZATION for emphasis. 

Use 24 lb. bond white or ivory paper on a laser quality printer. 
Proofread your work.  Have someone else proofread it. Then ask a counselor to proofread your work.  

Even the smallest mistakes are costly. 
Avoid using extra words such as ―a‖ or ―the.‖  (Example:  Answered multi-line phone system) 

Do not lie or exaggerate the truth. 
Cell phone number should be included only if you frequently check your messages or have a                 

  professional answer recorded for incoming callbacks. 
 

 



Use action verbs to describe your duties, skills, work experiences.  Use same verb tense for each verb chosen, usually the simple past 

tense. 

CREATIVE integrated budgeted monitored 

acted introduced calculated operated 

authorized invented catalogued organized 

chose launched classified prepared 

conceived marketed collected processed 

conceptualized opened compared purchased 

created ordered compiled recorded 

customized originated completed retrieved 

decided performed computed reviewed 

designed planned critiqued scheduled 

determined prepared decreased screened 

developed produced diagnosed specified 

devised proposed dispatched summarized 

directed resolved distributed surveyed 

enhanced revitalized evaluated systematized 

enlisted selected examined tabulated 

established set up executed validated 

fashioned shaped generated verified 

founded structured identified HUMAN RESOURCES 

formulated wrote implemented advised 

illustrated CLERICAL &  RESEARCH inspected assessed 

improved approved interpreted assisted 

initiated arranged interviewed clarified 

instituted automated investigated coached 
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HUMAN RESOURCES  
continued…….. 

computed set goals developed 

collaborated developed stimulated directed 

consulted forecasted trained drafted 

counseled managed TECHNICAL edited 

diagnosed marketed assembled enlisted 

educated planned built explained 

employed projected calculated formulated 

grouped researched computed influenced 

guided tabulated designed interpreted 

handled TEACHING devised interviewed 

hired adapted engineered investigated 

integrated advised fabricated lectured 

mediated clarified  maintained mediated 

monitored coached operated moderated 

motivated communicated overhauled negotiated 

negotiated coordinated programmed participated 

recruited demystified remodeled persuaded 

represented developed repaired presented 

sponsored enabled solved presided 

strengthened encouraged upgraded promoted 

trained evaluated COMMUNICATIONS publicized 

FINANCIAL explained addressed reconciled 

administrated facilitated arbitrated recruited 

allocated guided arranged represented 

analyzed influenced authored sold 

apprized informed collaborated spoke 

audited instructed consulted taught 

balanced interpreted contacted trained 

budgeted lectured convinced translated 

calculated persuaded corresponded wrote 

 

ACTION VERBS continued…..        Page 15 
     



MANAGEMENT &  

LEADERSHIP 

executed prioritized expanded 

accelerated expanded produced generated 

administered guided proposed identified 

analyzed headed recommended improved 

applied implemented reduced masterminded 

assigned improved reinforced pioneered 

attained incorporated repositioned rectified 

authorized increased retained single-handedly 

chaired initiated reviewed solved 

consolidated instituted revised strengthened 

contracted investigated scheduled surpassed 

controlled launched sorted turned around 

coordinated maintained strengthened was promoted to 

delegated managed supervised was responsible for 

developed mediated SUCCESS WORDS  

directed negotiated accomplished  

evaluated organized awarded  

enacted oversaw corrected  

established performed diverted  

exceeded planned eliminated  
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CREATE AN ASCII/PLAIN TEXT RESUME AND COVER LETTER 
  

 A text (or ASCII) resume will be stripped of formatting features such as bold and italics, so it may not appear very attractive to 
 you.  However, it will be universally compatible with all systems.  To convert your resume from MS Word to plain text. 

 
Open your resume document, go to Edit> Select All and change the font to Courier 12 point, go to File> Page Setup and change the left 

and right margins to 1.5 inches. 

Go to File> Save As> under ―Save as Type,‖ select ―Plain Text.‖ 
Select ―yes‖ at the prompt that warns about features being compatible. 

Name and save this file, then reopen the file, which should now have a text (.txt) extension. 
Review and clean up your document: 

 -Insert space where necessary   - Left-justify all text 
 -Change bullets to asterisks or dashes   -Take out tables and centering 

 -Change or remove symbols that didn’t convert properly 
Save your work! 

 

TEST THE FILE 
  

 Open your text resume, copy and paste it into your email message box and send it to yourself and a few friends to ensure that the 
 text transfers properly. 

 

CREATE THE E-MAIL MESSAGE 

 

 Follow the employers’ directions for applying to each position!  Requirements and instructions will differ, based on the individual 
 company’s needs.  If no specific instructions are given: 

 
Open your email program and set the message format to plain text, not HTML. 

Make the message Subject memorable!  ―My resume‖ isn’t going to grab the attention of a busy person.  Make the subject line rele-

vant, and include your name, e.g. ―Resume of Jane Smith—Copy Editor position.‖ 
Now create a ―cover letter‖ message just as you would in print, except leave off your mailing address, the date, and the recipient’s 

mailing address.  The message will begin with the salutation, e.g.: ―Dear Mr. Jones‖ 
Type your ―signature‖ at the bottom of your ―cover letter.‖  Avoid clever quotations/sayings in your email signature. 

After your signature, add a couple of blank lines and the text notation. 
 =================Resume Text Below========================= 

Add a couple more blank lines, then paste the text from your ASCII resume into the body of the email message. 
 -Unless the employer has requested no attachments, attach your Word resume.  This will accommodate employers who 

 prefer a traditional resume.  It doesn’t hurt to send your resume in both formats! 
 

  TIP:  When posting a resume to an online resume builder, use your 

          ASCII resume, and cut and paste it to fill the online form. 
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E-mail makes it possible for your to respond instantly to an opportunity but if not 

done correctly, your resume may be overlooked or deleted before it is read. 
 

 Whenever possible, copy a plain text (ASCII) resume into the body of your e-mail 

  message, rather than sending your resume as an attachment. Why? 

Attachments may contain viruses, particularly if they are in Microsoft 

Word. 

Firewalls may stop e-mail attachments from entering a company net-

work.  

Recruiters may not take the time to open the attachment. 



 
 

 
 

P  

ortfolios are great tools for students from all majors.  A professional portfolio is usually taken to an interview.  This 
type of portfolio is a documentation and demonstration of your accomplishments.  It shows growth in your skills and understanding over 

time.  A portfolio is not only documents your results but also how you got there and what you learned in the process. 
 

 

 

WHAT ARE THE BENEFITS OF PORTFOLIOS? 
 

Regardless of how you’ll use the finished product, all portfolios can help you: 
 

Write or update your resume more quickly, since all the relevant information will be in once place. 
Organize information you’ve gathered over the years, such as awards, certificates, and records of other accomplishments. 

Showcase your achievements, skills, and abilities for an interview. 

See your career as a collection of skills and talents that you’ve developed, rather than just a list of job titles. 
 

 
 

  
 

    E-PORTFOLIOS:  EFFECTIVE AND EASY 

 
  Electronic portfolios are an excellent way to showcase your skills and your  

  computer  abilities.  Remember more and more employers are seeking students  
  with high levels of technology skills.  The most effective portfolios are those that   

  are targeted towards a specific job organization. 
 

 

 
 

 

 

 

CREATIVE PORTFOLIOS 

 
A creative portfolio contains only samples of work relevant to your particular field.  Just like a professional portfolio, your creative portfo-

lio should be organized and presented in a quality format.  Many creative fields also expect a title page, essay, or artist statement and biog-
raphy.  Talk with people working in your field about the specific expectations for this type of portfolio. 
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